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Max’s Toolbox™

Introduction
What is Max’s Toolbox 3?
Max’s Toolbox 3 is an early childhood interface
to Microsoft® Office suitable for children in grades K
through 5. The flexibility of the programs makes
them suitable for teaching children of all
capabilities.
The suite of three products—MaxWrite for Microsoft®
Word, MaxShow for PowerPoint®, and MaxCount for
Excel—gives teachers a platform for incorporating
technology across a wide range of subjects and
lesson plans.

MaxWrite has easy-to-use icons and special tools
that make it fun and easy for students to express
themselves on the printed page. MaxWrite also
includes easy-to-use templates for invitations,
cards, and letters.
MaxShow encourages children to create fun,
powerful presentations with their own sounds
and pictures.
MaxCount gives young students an easy, attractive
way to learn about numbers, charts, and graphs.
Max’s Toolbox 3 contains creativity and management
tools not available in Microsoft® Office.

Max’s Toolbox 3 sits within the Microsoft® Office
environment and uses child-friendly lessons and
features to give young students productive and
creative ways to learn skills they will use throughout
their school years and beyond. Since all the
documents created with Max’s Toolbox 3 are actually
Microsoft® Office documents, they can be shared
with anyone who has Microsoft® Office.



MaxPaint is a fun and engaging drawing program
that works easily with all three programs.



MaxRecorder is a customized audio recording
and creativity tool built into MaxShow.

System Requirements

Checking your version of Office

The following system requirements are mandatory
for Max’s Toolbox 3:

If you are not sure what version of Office you have,
follow the steps below.

 Microsoft®
Microsoft®
Microsoft®
 Microsoft®

Windows® XP SP 2 with 512Mb RAM or
Windows® Vista with 1Gb RAM or
Windows® 7 with 1Gb RAM
Office 2007 or Microsoft® Office 2010

In addition, Max’s Toolbox 3 includes a set of
powerful Management Tools that allow teachers to
customize features and content for the needs of each
student.

1.

Launch Microsoft® Word.

2.

From the Help menu, choose About Microsoft®
Office Word.
Note: If you’re using Office 2007, click the Office
Button. Then, click the Word Options button. In the
Resources section, click the About button.
If you’re using Office 2010, click the File tab, and
choose the Help option.

The following systems requirements are the
recommended minimum for Max’s Toolbox 3:
 Intel Pentium III 500Mhz or higher for Windows XP
SP 2
 Intel Pentium III 800Mhz or higher for Windows
Vista
 1 gigahertz (GHz) processor or higher for Windows
7
 Minimum 1000 x 600 and 24 bit color
 CD-Rom Drive
 Windows Media Player for Insert Movie feature
 Sound card and speakers for text to speech
feature
 Microphone for recording feature
 380Mb Available Hard Disk Space for Complete
Installation.

3.

Look for the version number at the top of the
About Microsoft Office Word dialog box.

In the example below, the user has Office 2007 SP1.
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Using Max’s Toolbox 3 in
the Classroom
Name Art
Objectives
In this activity, students will learn how to:





Type their first name
Insert pictures
Save their document
Print their work

Description
7.

Save the document by clicking the Save
button. When saving a document, it is not
necessary to give the document a name. If no
document name is entered, the document will
be given a sequential number. Decide whether
you want students to enter a document name.

If a printer is available, demonstrate how each
student can print their pictures.

8.

Click the OK

Activity - Creating a document with name art

9.

Print the document by clicking the Print
button.

In this activity, students will use MaxWrite to type
their names.
Once they have typed their names, get each student
to insert three or more pictures that begin with the
same letters that appear in their names.

1.

Double-click the MaxWrite
icon.

desktop

2.

Click the New

3.

Select a blank document with landscape
orientation.

4.

Click the OK

5.

Type your first name.

6.

Insert a minimum of 3 pictures using the Insert
Picture

button.

button.

button.

10. Click the OK

button to save the document.

button to print the document.

11. Close MaxWrite by clicking the Exit
on the Quick Access Toolbar.

button
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Drawing a Picture

5.

Objectives
In this activity, students will:






Color the background. Click the Drawing
button and use these tools to fill in the
background:

Fill
, Pen
, Crayon
and Line Thicknesses.

Draw freehand
Use stamps
Edit their drawing
Save their document
Print their work

Description
In this activity, students will use MaxPaint to draw
and use stamps.
Once they have inserted their drawing into the
document, they will learn how to edit their drawing.
Have the students write a short sentence about
their drawing.
If a printer is available, demonstrate how each
student can print their pictures.
Activity - Drawing a picture

1.

Double-click the MaxWrite
icon.

desktop

2.

Click the New

3.

Select a blank document with portrait
orientation.

4.

Click the OK

5.

Click the MaxPaint
button. The MaxPaint
dialog box is displayed.

button.

button.

Demonstrate the MaxPaint tools.
1.

Choose the Drawing
and draw freehand.

tool and a Color

2.

Use the Eraser

and the Undo

3.

Click the Clear

button for a new screen.

4.

Click the Background
button to choose
a background. Select a background, then click on
your screen to apply it.

features.

, Straight Line

,

6.

Click the Stamps
button to add stamps.
Select a stamp, then click on your screen to
place the stamp.

7.

Click the Flip
of the stamp.

8.

When you have finished the picture, click the OK

button to change the direction

button and the picture will be inserted into
the main document.
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Activity - Editing a picture
1.

To make changes to a drawing, click on the
drawing and then click the MaxPaint
button.
The MaxPaint dialog box is displayed with the
drawing in it.

2.

Make changes as required.

3.

Click the OK
button to re-insert the picture
into your document.

4.

Have students write a sentence about
their picture.

5.

Save and print the document.

Max’s Toolbox™
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Basic Text Formatting
Objectives
In this activity, students will:





7.

Highlight the text.

8.

Click the Font Size
button. Then drag the
slider to the size you want the text.

Open a previously saved document
Read the text in a document
Format the text
Close a document

Description
Have the students open the document created
in the previous activity.
Use Read feature to read the text in the document.
Use the formatting features to change the look
of the text.
Activity - Basic text formatting

1. Click the Open

button and find the
document you saved in the previous activity.

9. Click the Color Effects

button. The Color

Effects features display.

10. Click the Random Color Letters

button to
randomly change the color of each letter.

2.

Select the document.

3.

Click the OK

4.

Click the Read

5.

Click the Features tab.

6.

Click the Formatting
button. The
Formatting features display.

button.
button to hear text read.

11. Save and close the document.
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Adding Text and Pictures to
a Presentation
Objectives

Max’s Toolbox™
7.

Add text to the slide by clicking within the text
box (which contains the text Click to add title)
and typing a title for your slide.

8.

Add a picture to the slide by clicking within the
picture box (which contains the text Click icon
to add clip art) and selecting a clip art picture.

9.

Click the Features tab.

In this activity, students will learn how to:





Create a new presentation
Type text into the presentation
Insert a picture into the presentation
Save their presentation

Description
Students will use MaxShow to create a new
presentation. They will add text to a text box, add a
picture to a picture box, and save and close the
presentation.

10. Add more text to the presentation by clicking
the Insert Text Box

button.

A text box will appear in the center of the slide.
You can move the text box by clicking and
dragging it to a new location.

Activity - Create a presentation and add text
and pictures
11. Click the Home tab.
1.

Double-click the MaxShow
icon.

2.

Talk about the toolbar buttons and their
purpose. Note that tooltips will appear
when the cursor is placed over each icon.

3.

desktop

Click the New Slide
button. The New Slide
dialog box offers 9 different slide styles to
choose from.

4.

Select the Title Clip slide style.

5.

Click the OK

6.

Explain that a slide contains different objects.
Explain the text boxes and picture boxes that
appear on the screen.

button.

Text box for entering text

Picture box for inserting a
picture

12. Add another picture to the presentation
by clicking the Insert Picture

button.

The Insert Picture dialog box is displayed.
After selecting a picture and clicking OK, the
picture will be inserted in the center of the
slide. You can move the picture by clicking and
dragging it to a new location.
13. Save and close the presentation.
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Create a Presentation about
Your Favorite Animal

4.

Objectives

5.

selected, and then click the OK





Create a new presentation based on
a template
Use MaxPaint to draw a favorite animal
Run a slide show
Save a presentation

button.

Demonstrate how to navigate between slides
using the Next Slide

In this activity, students will learn how to:


Make sure the Favorite Animal template is

Previous Slide

button and the

button.

6.

Navigate to Slide 1. Have each student click
to the right of "By" and type his or her name.

7.

Navigate to slide number 2 and have students
use MaxPaint to draw their favorite animal or
use Insert Picture to insert a picture of their
favorite animal.

8.

Navigate to slide number 3 and have students
enter text about why the animal is their
favorite.

9.

Demonstrate how to play the slide show by

Description
In this activity, students will use MaxShow to create
a new presentation based on a Favorites template,
draw their favorite animal using MaxPaint, or use
the Insert Picture feature to insert a picture of their
favorite animal.
Students will run the slide show with and without
sound.
Activity - Create a presentation based on the
Favorites templates

1.

Double-click the MaxShow
icon.

2.

Click the New

3.

Select the Favorites category.

desktop

button.

using the Run Slide Show

button.

10. Demonstrate how to play and read the slide
show by using the Run Slide Show with Sound
button.
11. Save and close the presentation.
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Attaching Sounds to Pictures
in a Presentation
Objectives:
In this activity, students will learn how to:




Open an existing presentation
Record a sound
Attach a sound to a picture

Description
In this activity, students will use MaxShow to
open the "My Favorite Animal" presentation saved
in the last activity. They will use MaxRecorder
to record a sound and then attach that sound to
their favorite animal picture.

4.

Click the Record
button and start recording
sound. MaxRecorder records up to 10 seconds of
sound.

5.

Click the Save

6.

Click the OK
button to close the
MaxRecorder dialog.

7.

Click the Open
button to open the "My
Favorite Animal" presentation saved in
the last activity.

8.

If the current presentation needs to be saved,

Students will run the slide show with sound and
mouse over their animal picture to hear their
recorded sound.
Activity - Recording a sound and attaching it
to a picture
1.

With MaxShow already open, click the
MaxRecorder

2.

button.

MaxRecorder allows students to create
new sounds and delete existing sounds.

click the OK

button to save the recording.

button.

If not, click the Cancel
9.

button.

Scroll through the existing presentations and
select the "My Favorite Animal" presentation
created in the last activity.

10. Click the OK

button.

11. Navigate to slide number 2 and select the
favorite animal picture.

3.

Click the New
the new sound.

button and type a name for

12. Click the Attach Sounds
button. The Attach
Sound dialog box is displayed.
13. Select the sound that was recorded earlier in
this activity.
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14. Click the OK
the picture.
15. Click the Play

button to attach the sound to

button to run slide show.

16. On Slide 2, place your mouse cursor over the
picture of your favorite animal to hear the
attached sound.

17. Save and close the presentation.
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9.

Picture Alphabet

Click the Color Effects
button. The Color
Effects Features will be displayed.

Objectives:
In this activity, students will learn how to:







Create a new presentation
Add text and pictures
Change the size and color of text
Change the color of the slide background
Add a new slide
Run a presentation

10. Change the color of the text by clicking the Font
Color
button. Click outside the text box to
deselect the text.
11. Change the color of the background by clicking
the Background Color

Description
In this activity, students will use MaxShow to create
a new presentation based on a blank template and
will create a slide for each letter of the alphabet.
Activity - Create a presentation showing the
Alphabet
1.

Click the New
presentation.

2.

Select the Blank slide style.

3.

Click the OK

4.

Click the Features tab.

5.

Add more text to the presentation by clicking

button.

12. Click the Home tab.
13. Use the Insert Picture
button to insert
pictures that start with the letter A.

button to create a new

button.

the Insert Text Box

button.

Aa.

6.

Type

7.

Highlight the text.

14. Add a new slide by clicking the New Slide
button.

8.

Make the text bigger by clicking the Font Size

15. Select the Blank slide style and click the OK

button on the Formatting group. Then, drag
the slider to the size you want.

button.
16. Repeat the steps above to create a slide
for each letter of the alphabet.
17. The presentation can be saved and opened at
a later time to finish the alphabet.
18. Run the slide show by clicking the Play
button.
Extending the activity
Have students record sounds for each picture (such
as “apple” and “ant”) and then attach the recorded
words to each picture.
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Counting Pets

4.

Type numbers in the cells as shown below. Type
the number and then press the Right Arrow Key
on the keyboard twice to move to the correct
cell for the next number.

5.

Use the Insert Picture
button to insert
clipart of pets into the spreadsheet. When
inserting a picture in MaxCount, the picture is
centered on the spreadsheet and will need to be
moved to the desired position.

6.

You can use the Copy
and Paste
buttons
on the Quick Access toolbar to quickly duplicate
the pictures.

7.

Save the spreadsheet by clicking the Save
button.

8.

Type the name of the spreadsheet (this is

Objectives
In this activity, students will learn how to:





Create a new spreadsheet
Type numbers into a spreadsheet
Identify numbers using pictures
Save a spreadsheet

Description
In this activity, students will use MaxCount to create
a new spreadsheet, type in the numbers 0 to 5, and
insert pictures to correspond to the numerals
entered.
Activity - Recognizing Numbers

1.

Double-click the MaxCount
icon.

desktop

2.

Create a new spreadsheet by clicking the New
button. The New dialog box is displayed.
3.

Select the spreadsheet you want to use and
click the OK

button.

optional) and click the OK
9.

button.

Print the spreadsheet by clicking the Print
button, and then clicking the OK

button.
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6.

Resize the rectangle and keep all the sides in
proportion by holding down the SHIFT key while
clicking and dragging the handles.

7.

Use the Triangle
the roof of the house.

8.

Resize the triangle and keep all the sides in
proportion by holding down the SHIFT key while
clicking and dragging the handles.

9.

Continue using different shapes to create a
picture of a house and trees.

Objectives
In this activity, students will learn how to:




Insert, resize, and color shapes
Type numbers into a spreadsheet
Create a legend and label for the
different shapes

Description
In this activity, students will use MaxCount to draw
a house and garden using shapes. They will use the
Shapes Toolbar to insert shapes and then create a
legend and identify the shapes they have drawn.
Activity - Drawing a house with Shapes
1.

Create a new spreadsheet by clicking the New
button and selecting the default template in
the Blank Cells category.

2.

Click the Features tab.

3.

Change the orientation to landscape by clicking
the Page Orientation button on the Formatting
group.

4.

Click the Shapes
Insert Shape

5.

button to draw

button, and then click the
button.

Use the Rectangle
button to draw
the body of the house. When inserting a shape
into MaxCount, the shape is centered on the
spreadsheet and will need to be moved to the
desired position.
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10. Color in the different shapes on your
spreadsheet by selecting the shape and then
selecting the Shape Fill Color

button.

13. Count the number of squares in your drawing,
type this number next to the picture of the
square in the legend and press ENTER
to move down to the next cell.
14. Count the number of triangles in your drawing,
type this number next to the picture of the
triangle in the legend, and press ENTER to move
down to the next cell.
15. Click the Home tab.
16. Save the spreadsheet by clicking the Save
button.
17. Type the name of the spreadsheet (this is
optional) and click the OK

button.

18. Print the spreadsheet by clicking the Print
button and then clicking the OK
11. Create a legend for the number of squares,
circles, and triangles used to create your house
and garden picture. Draw a small square, a small
circle, and a small triangle on the spreadsheet.
12. Count the number of circles in your drawing,
type this number next to the picture of the
circle in the legend and press ENTER to move
down to the next cell.

button.
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Weather Forecast Project

Sample of Slide 2

Objectives
In this activity, students will learn how to:




Create a presentation in MaxShow to display
weather symbols and a weather map of their
state
Create a chart in MaxCount to present the 5-day
forecast of their city
Create a document in MaxWrite to write a report
on their city's weather for today

Using MaxShow
1.

Create a new presentation with a blank slide.

2.

The first slide will be a legend page.

Sample of Slide 1

a.
b.
c.
d.
e.
f.
g.
h.
4.

a.

Click the Features tab.

b.

Click the Insert Text Box
button to
add a text box. Type the following text:
Weather Symbols
Using Insert Picture, add weather
symbols (see above for examples).
Resize and move symbols as required.
Add text boxes next to each picture
and type explanatory text.

c.
d.
e.
3.

Click the Home tab.
Create a new blank slide by clicking
the New Slide
button.
Use Insert Picture to insert a map
of your state.
Resize the image to fit the whole slide.
Select the map and click the MaxPaint
button.
Add text boxes and type the names of
several major cities in your state.
Create a title at the top of the slide
using a text box and type the state
name and date.
Create a legend at the bottom of
the slide by adding text boxes.

Save the presentation.

Using MaxCount
1.

Create a spreadsheet with Landscape
orientation.
Sample of Data and Line Chart

The second slide will be a map of your state.

2.

Enter low and high temperature data for your
city.

Max’s Toolbox™
3.

Create a Line Chart from the data you entered.

4.

Save the spreadsheet.

Copying Chart to MaxShow
With MaxShow and MaxCount and the two previous
documents open:
1.

In MaxShow, create a new blank slide in
your presentation.

2.

Switch to MaxCount and select the chart.
Click the Copy button.

3.

Switch to MaxShow on the new blank slide
and click the Paste button.

4.

Save the presentation.

Using MaxWrite
1.

Create a blank document or one with a border.
Sample Weather Report

2.

Write a report based on today's weather and
draw a picture that relates to today's weather.

3.

Save the document.
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